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2 Introduction 

2.1 About this booklet 

On the following pages, we would like to present to you the feature highlights 
of version 8.7 of GAMMA Dental Software (GDSW). This update includes 
many improvements and new features for the CADIAX, CADIAS, and CA-
DIAS 3D analysis modules as well as for the patient management in GAMMA 
Document Browser and GDSW classic. 

Several of the changes implemented in this software version have been sug-
gested by our user basis worldwide. If you also have ideas or suggestions for 
possible improvements, please do not hesitate to contact us. 

2.2 Downloading the software 

The most recent version of GAMMA Dental Software is available for down-
load via the Downloads section of our website at www.gammadental.com. 
There, you can also find the current operating instructions for all our products 
and additional information material for free and without registration. 

 

You can also request a paper copy of the operating instructions 
by contacting us directly. Shipping within the European Union is 
free of charge. 

 

After having downloaded the installation package as a setup file, simply exe-
cute that file to start the installation. 

2.3 Installing from the flash drive 

GAMMA Dental Software is also 
available on a USB flash drive that 
contains not just the software in-
stallation package, but also the op-
erating instructions in PDF format. 
This flash drive is write-protected 
and will appear as an additional 
drive named “GDSW” in your file 
explorer when plugged in. Figure 1: The GDSW flash drive. 

https://www.gammadental.com/
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To start the installation, simply insert the USB flash drive into a free USB port 
of your computer. The logo printed on the flash drive should typically be lo-
cated on the top side. If the installation routine does not start automatically, 
you can launch it by executing the file setup.exe that you can find in the folder 
Setup on the GDSW drive. The operating instructions are located in the sub-
folder Manuals. A suitable PDF viewer application is included with every Win-
dows installation. 

2.4 Installation procedure 

If an older version of GAMMA Dental Software already exists on your com-
puter, the installation routine will perform an update, which will preserve your 
personal configuration settings. The update procedure will in no way touch 
your pre-existing patient files. Nevertheless, we recommend backing up 
your patient data before installing the update. You can easily identify the 
patient files to back up by their *.fgw (GDSW classic) and *.gdb (GAMMA 
Document Browser) file extensions. The database directory where these files 
are located is indicated in the respective application. 

Do not switch off your computer during the installation. If you are installing 
the software on a laptop computer, please ensure that it will not run out of 
power during the installation procedure. 

Furthermore, please ensure that you have your license code at hand when 
launching the installation routine. You can find this code on your license letter 
that you received as part of the installation package. Contact us if you need 
a copy of the license letter at a later time.  
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In the very first steps of the installation procedure, you are asked to choose 
the language to be used for the software and to accept the license agree-
ment. 

Afterwards, please enter your license code and optionally your user infor-
mation (Figure 2). The latter is used for identifying the workstation and your 
practice or company on the printouts created by the software. Click Next to 
continue. 

 
Figure 2: Enter your user information and the license code. 

In the subsequent step, you can change the directory to which the software 
will be installed. We recommend to proceed with the predefined settings. 



GAMMA Dental Software 

7 

Afterwards, you will be asked to specify the directory in which you want to 
store your patient data (Figure 3). If you need to access the data from multiple 
PCs, you can specify a network drive that is accessible to all of them. 

 
Figure 3: Select the directory in which your patient data should be stored. 

The next window summarizes the installation settings. To change any of 
them, go back to the respective step by clicking on Back. 
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2.5 Software activation 

After the successful installation of GAMMA Dental Software, you can choose 
to start either GDSW classic or GAMMA Document Browser. In either case, 
you will be asked to activate the software (Figure 4). 

 
Figure 4: Activation is always performed for the complete GDSW package, regard-
less of which application invoked it. 

The activation procedure has to be carried out only when you start the soft-
ware for the very first time. Depending on the license code entered during 
installation, different software modules will be made available. To check your 
license information or enter a new license code after activation, use the menu 
Help > About in the software. 

Warning: 

Using GAMMA Dental Software in a virtual environment (e.g., Parallels® 
Desktop) may cause poor performance or even loss of certain functionalities. 

If you plan to use the software in a virtual environment anyway, we strongly 
recommend updating both your operating system and your virtualization soft-
ware to the latest version before activating. Subsequent updates of these 
components can cause a change of the system information that is registered 
by GAMMA Dental Software, which will render your activation invalid. 
GAMMA does not take any responsibility for validity of license codes being 
lost this way. For these reasons, please use a native Windows environment 
instead (e.g., Boot Camp on Apple macOS computers, if available). 
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For activating GAMMA Dental Software on a computer with internet connec-
tion, simply select Online activation in the following dialog (Figure 5) and click 
on Activate. No further steps are required in this case and you can immedi-
ately start using the software. 

 
Figure 5: An active internet connection is convenient, but however not necessary 
when activating GAMMA Dental Software. 

If you are installing GAMMA Dental Software on a computer without an active 
internet connection, please select Offline activation. Send the displayed acti-
vation code to GAMMA either via e-mail or by fax or visit the GAMMA activa-
tion website (Figure 6) on another device to activate your software: 

http://activation.gammadental.com/ 

http://activation.gammadental.com/


GAMMA Dental Software 

10 

Enter your customer number and 
the activation code shown in the 
software and click on Activate. 
The system provides Export and 
Import functionalities on both 
ends to minimize the risk of typo-
graphic mistakes. 

The website will return a confir-
mation code, which you will have 
to enter in the corresponding in-
put box of the activation dialog 
(Figure 5). By clicking on Acti-
vate, software activation is now 
also completed on a system with-
out internet connection. 

GAMMA Dental Software is now 
ready for use. In case of any 
questions regarding the installa-
tion or usage of the software, please do not hesitate to contact us via: 

E-Mail: support@gammadental.com 

Phone: +43 2243 34140 

Fax: +43 2243 34140 90 

Our hotline is at your disposal from Monday to Friday between 9 AM and 
4 PM (local time Vienna). 

Figure 6: Offline activation enables you to 
activate the software on computers without 
an internet connection. 

mailto:support@gammadental.com
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3 Updates in version 8.7 

3.1 CADIAS 3D 

Undoubtedly, computerized digital methods are an ongoing important factor 
in modern dentistry. Typical dental developments in the industry aim directly 
at the design and manufacturing of prosthetic appliances in the dental labor-
atory, wherefore digital dentistry nowadays is more a topic for the dental lab 
than it is for the practitioner’s office. The aspects of functional analysis are 
widely ignored or neglected by those developments. 

The field of instrumental functional analysis is one of the key points of the 
Vienna School of Interdisciplinary Dentistry (VieSID) in the systematic ap-
proach to establish valid and patient-specific evaluations. In particular, occlu-
sal analysis of articulated models is of prime importance. With CADIAS 3D, 
GAMMA has developed a sophisticated 3D software system that aims to fill 
the gap in digital dentistry to allow occlusal model analysis as part of the 
computerized workflow. 

 

For a complete overview of the features provided by CADIAS 3D, please refer 
to the operating instructions of GAMMA Dental Software, which you can also 
access via the Help menu in the software. The software comes with a fully 
documented patient case, named “Test Patient 3”, which you can use to get 
acquainted and experiment with CADIAS 3D. Go ahead and give it a try! 
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3.1.1 Axis-related transfer of intraoral scans to the virtual articulator 

In conventional digital workflows with intraoral scanners, the models are often 
placed at an average position in the articulator as they possess no defined 
relationship with a cranial reference plane. For virtual functional analysis how-
ever, it is crucial that the jaw models are correctly positioned relative to the 
articulator’s hinge axis. If this relationship does not match the anatomical ge-
ometry of the patient, it will distort the measurements of basic parameters 
such as condylar guidance or occlusion plane inclination as well as static and 
dynamic occlusal contacts. 

GAMMA has developed a new direct digital workflow that, for the first time, 
allows an axis-related transfer of intraorally scanned jaw models into the vir-
tual articulator without relying on a digital facebow. Our innovative method is 
characterized by excellent accuracy and ease of use, as well as low cost. It 
is compatible with existing GAMMA facebows for both anatomical and exact 
hinge axis and almost all commercially available intraoral scanners. 

The direct digital workflow is fully integrated in version 8.7 of GAMMA Dental 
Software and comprises the following steps: 

 

2) Mount the facebow on the pa-
tient and take the upper jaw im-
pressions. It should cover the 
full arch by using silicone, bite 
registration material, or similar. 

1) Create the intraoral scans of 
upper and lower jaw in bite re-
lation or in reference position 
using a centric registrate. 
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5) The bite fork scan captures the 
upper jaw position relative to 
the transfer block. The gap in 
between may be filled with bite 
registration material. 

6) During the 3D data import, the 
intraoral and bite fork scan are 
aligned to the digital transfer 
block and thus correctly posi-
tioned in the articulator. 

4) Take a scan the upper jaw im-
pressions together with the 
transfer block, using the in-
traoral scanner in the transfer 
stand or articulator. 

3) Mount the facebow in the 
transfer stand or articulator. 
Select the transfer block that is 
suitable for the bite fork posi-
tion (order no.: 06-230950). 
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To start with the alignment of intraoral scans to the bite fork scan and subse-
quently to the digital transfer block, the 3D Data Assistant provides a but-

ton   Articulate intraoral scans  in the side panel. 

3.1.2 Simultaneous import of upper and lower jaw in the 3D Data Assistant 

As part of the digital workflow de-
scribed above, the import proce-
dure for 3D data has been com-
pletely revised and now allows 
the simultaneous import of upper 
and lower jaw models. The corre-
sponding scan files can simply 
be loaded via drag-and-drop. 
The interrelation of the two mod-
els will at all times be preserved 
as it was created by the lab scan-
ner or intraoral scanner. 

Additionally, the 3D Data Assis-
tant can now be started directly 
from CADIAS 3D. 

3.1.3 Automatic intelligent tooth segmentation 

For analyzing static and dynamic 
tooth contacts in CADIAS 3D, it is 
necessary to segment the indi-
vidual teeth of the models. Until 
now, this segmentation had to be 
carried out manually by tracing 
the outline of each tooth. 

The update to version 8.7 now in-
cludes an intelligent software al-
gorithm that allows automatically 
segmenting individual teeth with 
a single click. This significantly 
simplifies the preparation work 
required for occlusion analysis. 

Figure 7: Importing upper and lower jaw 
model at the same time in the 3D Data 
Assistant. 

Figure 8: The segmentation of individual 
teeth of the dental models can now be car-
ried out with a single mouse click. 
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3.1.4 Export of graphical analyses for CAD/CAM 

Graphical analyses in CADIAS 3D are useful for the visualization of anatom-
ical parameters measured on the jaw models, such as occlusal plane, curve 
of Spee, or the dental arches of active and passive centric. These visualiza-
tions, including the reference planes of the articulator coordinate system, can 
now be exported as 3D objects via the menu File > Export for the use in 
external CAD/CAM applications. This allows for a verification of the axis-re-
lated model position as well as the inclusion of VTO-planned target parame-
ters in the occlusion design. 

  

Figure 9: Export of reference planes and graphical analyses for transferring model 
position and design targets to external CAD/CAM applications. 

3.1.5 Lower jaw animation in Occlusion Design 

The Occlusion Design view allows 
defining a series of lower jaw move-
ments guided by the Sequence in-
cisal table. These can subsequently 
be exported as Jaw Motion files and 
be used in CAD/CAM software such 
as Exocad for the virtual wax-up ac-
cording to the principles of sequen-
tial occlusion. 

To preview the generated lower jaw 
movements that are to be exported, 
the Occlusion Design view now al-
lows replaying the movements di-
rectly in the 3D environment. 

Figure 10: Replay of lower jaw move-
ments guided by the Sequence incisal 
table in Occlusion Design. 
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3.1.6 Exporting cusp movement tracks for CAD/CAM 

The Sequence incisal table in the Occlusion Design view of CADIAS 3D de-
fines an incrementally decreasing sequence of laterotrusive guidance angles, 
which allow for the virtual wax-up according to the principles of sequential 
occlusion. The resulting movement paths of the cusps of the lower active 
centric arch are visualized in the 3D environment and animated during the 
movement replay in the Occlusion Design view. 

When using this functionality to export the lower jaw movements as Jaw Mo-
tion files, an additional export option now allows those movement tracks to 
be exported as 3D objects. In external CAD/CAM software, these tracks can 
then be used as a visual template for the wax-up of the occlusal guidances 
in the maxillary occlusion or their verification. 

  

Figure 11: Export of cusp movement tracks as 3D objects for CAD/CAM. 

3.1.7 Sequence table integrated in the articulator settings 

The Sequence incisal table that was 
hitherto only available in the Occlu-
sion Design view is now also part of 
the regular articulator settings that 
can be adjusted in the Workspace 
and Dynamic Occlusal Protocol 
views. Possible adjustments include 
the color of the inserts as well as the 
position of the table (F = protrusive, 
3 to 6 = laterotrusive). The corre-
sponding guidance angles conven-
iently appear as tooltips. 

Figure 12: The Sequence incisal table is 
now part of the articulator settings and 
adjustable in the Workspace view. 
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3.1.8 Export of individual lower jaw movements 

In addition to exporting lower jaw movements for sequential wax-up using the 
Occlusion Design view, it is now also possible to export individual condylog-
raphy or articulator movements via the menu File > Export in the Workspace. 
These movements consider the settings pertaining to the incisal table guid-
ance and model collision that were set in the Dynamics tool window. 

3.1.9 Improved CPM computation 

Following the calculation of a 
condyle position measurement 
(CPM), it is now possible to invert 
the calculation result without re-
peating the calculation. This al-
lows for an easier assessment of 
the bidirectional differences be-
tween two condyle positions, 
such as from intercuspation 
(ICP) to reference position and 
vice versa. In addition, the initial 
calculation speed has been im-
proved significantly. 

3.1.10 Adjustment of background color and rendering GPU  

A new Options dialog for CA-
DIAS 3D, which is accessible via 
the menu Extras > Options, now 
allows adjusting the background 
color of the 3D environment. This 
allows you to customize the ap-
pearance to your preferences 
while also simplifying back-
ground removal for screenshots.  

In the same dialog, it is possible 
to adjust the GPU that is used for 
rendering the 3D scene. This can 
be useful on notebooks with a 
hybrid setup of integrated and 
dedicated graphics processor. 

Figure 13: The result of a CPM calculation 
can now be inverted easily with the press 
of a button. 

Figure 14: Adjusting the background color 
and rendering GPU in the new Options 
dialog of CADIAS 3D. 
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3.1.11 Improved display of true-color scans 

To improve the display quality of 
tooth surfaces, models that contain 
true color information, such as in-
traoral scans, can now also be dis-
played with smooth shading mode. 
Using the context menu of objects in 
the 3D view, it is possible to switch 
between flat and smooth shading 
mode and to turn on or off the use of 
true color. False color may be pref-
erable for occlusal contact analysis. 

3.1.12 Miscellaneous improvements 

– With VTO mode activated, it is now possible to select multiple mod-
els or teeth by holding down the Ctrl or Shift keys and to reposition 
them simultaneously. 

– In the VTO selection dialog, it is now possible to duplicate VTO 
items via the context menu. This simplifies scenarios such as the 
creation of a series of interdependent treatment objectives. 

– The custom measurements of points, lines, angles, etc., can now 
be modified by dragging the individual measurement points on the 
surface of the model. 

– When importing 3D models in the 3D Data Assistant, it is now pos-
sible to invert the surface direction of the mesh, which allows cor-
recting potentially erroneous scan data. 

– The adjustment range of the articulator’s sagittal condylar inclina-
tion (SCI) setting has been raised from 70° to 90°. 

– The 3D data import now supports meshes comprised of quadrilat-
eral rather than triangular faces. 

3.1.13 Fixed issues 

– The performance of the image overlay has been improved signifi-
cantly and a potential related application crash has been resolved. 

– Minute numerical imprecisions during the incisal table guidance of 
lower jaw movements have been fixed. 

Figure 15: Display of true-color model 
scans using flat shading (left) and 
smooth shading (right). 
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3.2 General 

3.2.1 Revised diagnostic sheet for VieSID and DC/TMD 

The diagnostic sheet of GAMMA Document Browser and the CADIAS Ana-
lyzer application (when launched from GDSW classic) has been revised in 
cooperation with experts of the Vienna School of Interdisciplinary Dentistry 
(VieSID) to conform with the typical patient anamnesis procedure and the 
associated documentation requirements. The changes include the question-
naire of the dental history analysis, the sequence of muscle palpation, which 
is now more clearly separated into muscles to be palpated intraorally and 
extraorally, as well as the input of specific clinical symptoms in the section for 
myofunctional disturbances. 

The diagnostic sheet now also provides additional input fields for document-
ing the Diagnostic Criteria of Temporomandibular Disorders (DC/TMD)1, in-
cluding a graphic for tooth and tongue status. 

  

Figure 16: Additional input fields in the diagnostic sheet now allow documenting 
the patient anamnesis according to the requirements of VieSID and DC/TMD. 

 
1 Schiffman E et al.; International RDC/TMD Consortium Network, International association for Dental 
Research; Orofacial Pain Special Interest Group, International Association for the Study of Pain. Diag-
nostic Criteria for Temporomandibular Disorders (DC/TMD) for Clinical and Research Applications: 
recommendations of the International RDC/TMD Consortium Network* and Orofacial Pain Special In-
terest Group†. J Oral Facial Pain Headache. 2014 Winter;28(1):6-27. DOI: 10.11607/jop.1151. PMID: 
24482784; PMCID: PMC4478082. 

https://doi.org/10.11607/jop.1151
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3.2.2 Recovery files for diagnostic sheet 

As a safeguard for the diagnostic sheet information created during patient 
anamnesis, the inputs are now stored as recovery files, which can be restored 
via the File menu in case of a saving error or system crash. 

3.2.3 Simplified licensing scheme 

The licensing scheme of GAMMA Dental Software has been simplified and 
now provides module versions “C3D” and “C3D+”, which better support the 
requirements of the digital workflow. The latter module version unifies and 
replaces the previous “CW”, “S”, and “LAB” variants. 

Software module Viewer C C3D C3D+ AM 

GAMMA Document Browser      

GDSW classic  
 

   

CADIAS® 3D virtual occlusion analysis  (*)
     

CADIAX® condylography analysis  (*)
     

Condylography with CADIAX® compact 2   
   

Condylography with CADIAX® 4  
 

   

CADIAS® cephalometric analysis  (*) 
 

   

(*) read-only access      

3.2.4 Discontinuation of 32-bit support 

The modern features and software algorithms implemented in this version 
necessitate the use of a 64-bit operating system for technical reasons. Due 
to the vanishingly low market share of 32-bit Windows installations and the 
discontinuation of such an option with actual Windows versions, GAMMA 
Dental Software is now only available as 64-bit software. This simplifies the 
installation procedure and also reduces the size of the installation package 
by roughly 20%, consequently resulting in quicker software downloads. 

3.2.5 Miscellaneous improvements 

– The user interface has been improved in several locations to better 
support display scaling on high-definition screens, including the 
toolbar in CADIAS 3D and the patient tree in GDSW classic. 
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3.3 GAMMA Document Browser 

3.3.1 Automatic image import during GDSW classic conversion 

When converting patient files of GDSW classic to the GAMMA Document 
Browser format, linked image files in CADIAS, such as x-ray images and pa-
tient photos, are now automatically imported into the converted patient file – 
provided the linked image files are accessible. 

3.3.2 Copying and pasting images in the Image Assistant 

The Image Assistant of GAMMA Document Browser now allows copying the 
displayed image to the clipboard using the standard keyboard combination 
Ctrl+C, which can subsequently be pasted in external applications. Con-
versely, it is now also possible to paste already copied images in the Image 
Assistant using the keyboard combination Ctrl+V. 

3.3.3 Miscellaneous improvements 

– In the Cell Design view, it is now possible to select multiple cell 
design elements by holding down the Ctrl or Shift modifier keys and 
modifying them at once. 

– When opening a diagnostic sheet in the Workspace, the form sheet 
now automatically scrolls to the section displayed in the preview. 

– The handling of errors that could occur during the conversion of old 
Microsoft Access-based patient files into the current format has 
been improved. 

– Support for schema design templates containing cells with a 16:9 
aspect ratio has been improved. Predefined sets of schema design 
templates in the widescreen format are available for download from 
our website. 

3.3.4 Fixed issues 

– A possible application hang when closing the diagnostic sheet ed-
itor and the patient file in quick succession has been fixed. 

– An error that caused imported user-defined image types to only 
appear when the Options dialog was opened for the first time has 
been resolved. 
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3.4 CADIAX 

3.4.1 Improved curve selection for articulator calculation 

The selection of curves for the calcula-
tion of articulator settings in the CADIAX 
Analyzer application can be carried out 
via the context menu or the drop-down 
boxes in the contents list. When scrolling 
this list with the mouse wheel, it was eas-
ily possible to change the curve selection 
by accident. To prevent this from hap-
pening, changing the selection now re-
quires explicitly selecting the respective 
curve in the list beforehand. 

3.4.2 Miscellaneous improvements 

– The XML and ASCII export/import in the CADIAX compact 2 Re-
corder is now also possible when the application has been started 
from GAMMA Document Browser or GDSW classic. 

3.4.3 Fixed issues 

– When opening a recording file of CADIAX compact 2 Recorder, the 
curve selection for articulator calculation is now restored correctly. 

– Incorrect designations of measurement units for coordinates and 
angles in the input mask for numeric curves have been corrected. 

3.5 CADIAS 

3.5.1 Miscellaneous improvements 

– The Xi point that describes the center of mass of the ascending 
mandibular ramus now supports a more stable calculation mode 
that prevents positional changes of the point during VTO modifica-
tions. For more information to enable the new calculation mode, 
please contact us directly. 

– The error messages shown for incorrectly digitized mandibular ra-
mus contours and the DC point have been revised to better de-
scribe the respective error. 

Figure 17: Selection of CADIAX 
curves for articulator calculation. 
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Notes 



 

 

 


